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MAJOR 
CHANGES: 

The purpose of this reference guide is to inform all District personnel of the 
requirement to use the Welligent Management System’s Section 504 Program 
module for all Section 504 activities.   
 
As of July 1, 2014, the Welligent Section 504 Program module replaced the 
Student Information System (SIS) database as the official source for 
maintaining, updating, and managing Section 504 data. This reference guide 
outlines procedures and instructions for Section 504 Designees, Case Managers, 
and Modified Consent Decree (MCD) Clerks (Senior Office Technicians and 
Office Technicians assigned to special education and Section 504 duties) to 
follow when conducting Section 504 activities and updating all current students’ 
Section 504 details and documents in the Welligent System.   
 
This reference guide replaces REF-6241.2. All Section 504 forms must be 
developed and saved within the Welligent system.  Upon completion of each 
Section 504 evaluation, a complete set of Section 504 documents, including 
supplemental pages and forms with signatures, must be uploaded and attached to 
each student’s Section 504 record.  Welligent 8 now has exclusive compatibility 
with Internet Explorer and Safari browsers.  Screen shots and instructions for 
developing, revising, and saving forms within the Welligent Section 504 
Program Module have been updated to reflect the Welligent 8 System.       

  
BACKGROUND: 
 
 
 
 
 
 
 

Section 504 of the Rehabilitation Act of 1973 (Section 504) is a civil rights law 
that prohibits discrimination/harassment on the basis of disability in any 
program or activity receiving federal financial assistance. The District has 
specific responsibilities related to the provision of a "free appropriate public 
education" (FAPE) to school age individuals with disabilities under Section 
504and the Individuals with Disabilities Education Act (IDEA). 

 

ROUTING 
Local Districts 
Administrators of Operations 
Principals  
Administrators  
School Counselors  
School Nurses 
Section 504 Designees 
Section 504 Case Managers 
MCD Clerks (Senior Office 
Techs & Office Techs - 
assigned to special education 
and Section 504 duties)  
Teachers 
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BACKGROUND 
(continued): 

As a result of the Americans with Disabilities Act Amendments Act (ADAAA) 
there is a broader application of the definition of disability under the Americans 
with Disabilities Act (ADA) and Section 504. The new law eliminated the 
consideration of ameliorative effects of mitigating measures when determining 
whether a student has a disability, though they remain relevant when evaluating 
students' needs for accommodations/services.  As a result, more students may 
be eligible for Section 504 nondiscrimination protections whether or not they 
currently need Section 504 plan accommodations/services. 
 
The Los Angeles Unified School District currently utilizes a web based student 
data management system and record archive referred to as the Welligent 
Individualized Education Program (IEP) Management System to provide access 
to students’ records under IDEA. The Welligent Management System continues 
to evolve in order to provide increased access to and maintenance of students’ 
educational records, including, but not limited to, special education and Section 
504 records. 
 
During the 2013-2014 school year, the Welligent Section 504 Program module 
was developed to provide increased access to students’ Section 504 records.  
School personnel are required to use the Welligent Section 504 Program module 
when conducting Section 504 activities regarding referral, evaluation, plan 
development, and follow up, in order to more effectively serve, monitor, and 
track students with disabilities under Section 504.  The Welligent Section 504 
Program module presents the Section 504 process as a sequence of four phases: 
I. Management; II. Evaluation; III. Meeting; and IV. Follow Up.   
 

PROCEDURES: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I. LAUSD Section 504 Designees, Case Managers, and Modified Consent 
Decree Clerks who do not currently have an active Welligent account 
should complete the following steps before attempting to access the 
Welligent Management System Section 504 Program module: 
 
A.   Activate their account by visiting the Welligent Support Unit at 

https://idmlogin.lausd.net/myprofile/ 
 

B.   Review Welligent Support Technical Guide (Attachment A) regarding 
minimum requirements for Windows and Macintosh operating systems 
to improve user functionality. 
• Internet Explorer is the required browser for PC users when 

accessing the Welligent Section 504 Program Module;  
• Safari is required for Macintosh users; however, use of a Macintosh 

may limit functionality; and 
• Firefox, Chrome and Windows Edge are not compatible browsers; 

therefore, a loss of functionality would result.    
 

II. Section 504 Designees, Case Managers, and MCD Clerks should identify 
students currently eligible under Section 504 at their school by following 
instructions outlined in the Welligent Section 504 Program Module Quick 
Sheet (Attachment B: #12) to generate a Welligent Section 504 Report. 
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PROCEDURES 
(continued): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Review the report for accuracy and update the information in the 
Welligent Section 504 Program module “Section 504 Details” as 
necessary. 
 

A.   Locate the most current Section 504 Plan for each student.   
 

1. All current Section 504 documents with signatures and 
supplemental pages should be scanned and uploaded as an 
attachment to the student’s Welligent Section 504 record 
immediately upon completion of the Section 504 evaluation.  

2. If the Section 504 Plan cannot be located in the student’s 
cumulative record folder or Welligent, follow procedures in the 
most current BUL-4692. Section 504 of the Rehabilitation Act of 
1973, to conduct a Section 504 re-evaluation using the Welligent 
Section 504 Program module as outlined in Section III of this 
reference guide. 

 
B. Conduct a student record search in Welligent to determine if a Section 

504 record has been previously created by following instructions 
outlined in the Welligent Section 504 Program Module Quick Sheet 
(Attachment B). 
 
1. If a record has been created, review Section 504 Details and 

update if necessary. 
a. Review Welligent Section 504 documents to determine 

if they are complete and delete any duplication 
(Attachment B: #9). 

b. If no documents can be located, check to see if the 
records were previously scanned and attached 
(Attachment B: #7).      

2. If there is no Section 504 student record in the Welligent Section 
504 Program module for a student who has a Section 504 plan in 
the cumulative record, proceed to step C below.  
 

C. Create a Section 504 record in the Welligent Section 504 Program 
module for each student following the procedures outlined in 
Welligent Section 504 Program Module Quick Sheet (Attachment B). 
 
1. Update/enter Section 504 details (Attachment B: #5). 
2. Scan and/or attach relevant Section 504 plan documents to the 

student record (Attachment B: #7). 
 

III.  All documents for future Section 504 initial evaluations, re-evaluations, 
and manifestation determinations shall be developed and saved within the 
Welligent Section 504 Program module following the instructions 
outlined in the Welligent Section 504 Program Module Quick Sheet 
(Attachment B: #3-7).  

IV.  Upon accessing the Welligent Management System, follow instructions   
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PROCEDURES 
(continued): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
AUTHORITY: 
 
 
RELATED 
RESOURCES: 
 

outlined in Attachment B when conducting the following activities as 
necessary: 
 
1. Locating a Student Record/Student Record Search 
2.  Locating the Section 504 Student Record 
3.  Creating the Section 504 Record for the First Time 
4.  Editing the Section 504 Student Record 
5.  Updating Section 504 Details and Creating Forms 
6.  Creating Forms for a Re-Evaluation 
7.  Attaching Relevant Section 504 Documents to the Student Record 
8.  Receiving System Alerts 
9.  Deleting a Section 504 Form  
10.  Locking a Section 504 Form  
11.  Generating a Section 504 Report  

 
V. Welligent Section 504 Program module users may utilize the following 

options for additional assistance: 
 

A. MyPLN Training – “Welligent Section 504 Self-Guided Lab”   
Online training in a computer lab format with step-by-step 
instructions on generating Section 504 reports, creating records, and 
updating Section 504 details in the Welligent Section 504 Program 
Module. 
 

B. Learning Zone Training – “Special Education and Section 504 MCD 
Clerk Training”  
Outlines procedures, specific roles, and responsibilities of clerical 
staff assigned special education and Section 504 tasks as required by 
the MCD https://lz.lausd.net/lz/index.jsp. 
 

C. Learning Zone Training – “Section 504 Procedures”  
Outlines the four phases of the Section 504 process 
https://lz.lausd.net/lz/index.jsp.  

 
 
This is a policy of the Superintendent of Schools.   
 
 
 
BUL-4692. Section 504 of the Rehabilitation Act of 1973, issued by the Office 
of the General Counsel 
 
REF-5640. Clerical Support for Special Education and Section 504 as Required 
by the Modified Consent Decree, issued by the Division of Special Education 
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ASSISTANCE: 
 
 
 
 
 
 
 

 
 
 
 
ATTACHMENTS: 
 
 

 

 

For further information, contact the following District Offices: 
 
Educational Equity Compliance Office (EECO):  (213) 241-7682   
Visit the EECO website for related information:  http://achieve.lausd.net/eeco 
 
District Nursing Services:  (213) 202-7580 
 
Your Local District Operations/Section 504 Designee 
 
Information Technology (ITD) Help Desk (213) 241-5200 
https://lausd-myit.onbmc.com 
 
 
Attachment A - Welligent Support Technical Guide 
Attachment B - Welligent Section 504 Program Module Quick Sheet  
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Welligent Supported Operating Systems and Browser Versions 

OPERATING SYSTEM (OS)  BROWSER 

 Windows 7 or higher Internet Explorer 11 

Mac OS Safari 6.x or higher 

NON-COMPATIBLE BROWSERS:  Mozilla Firefox, Google Chrome and Windows Edge 

WINDOWS 

Display Internet Explorer Menu Bar Allows you to follow the settings instructions listed below 

 Open Internet Explorer   {Fig.1} 

 Top right of screen, right-click on a blank area of the Title Bar to

display pop-up menu (Fig.1) 

 Click on Menu Bar to activate (Fig.1)

 The Menu Bar displays  at top left (Fig.2)   {Fig.2} 

Clear Compatibility View Settings  Required for Version 8 

 Open Internet Explorer         {Fig.3} 

 From the Menu Bar click on Tools, click Compatibility View Settings

 If lausd.net is displayed under Websites you’ve added to Compatibility View,

it needs to be removed: 1. Click on lausd.net and it will highlight in blue

2. Click on the Remove button on the right

 Remove the checkboxes next to Display intranet sites in Compatibility View

& Use Microsft compatibility list

 Ensure that the settings are blank as shown in (Fig.3) 

 Click on Close

Temporary Internet File Settings    Refreshes the web page to the current information 
 Open Internet Explorer     {Fig.4} 

 On the Tools menu, click Internet Options

 On the General tab, under Browsing History, click on

the Settings button (Fig.4)       {Fig.5}

 Under “Check for newer versions of

stored pages:”

Select Every time I visit the webpage

(Fig.5)

 Disk space to use should be set to

250 MB (Fig.5)

 Click on OK, and Ok to close screen

Pop-up Blocker Turn off the Pop-up blocker for the Welligent website 

 Click Tools from the IE Menu bar  {Fig.6} 

 Select Pop-up Blocker

 Click on Pop-up Blocker Settings

 Type: https://welligent.lausd.net under address

of website to allow (Fig.6) 

 Click the Add button (Fig.6) 

 Click on Close

Attachment A
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WINDOWS 

Adjust Printing Print IEP documents on one sheet  

 Open Internet Explorer   {Fig.7} 

 On the File menu, click Page Setup

 Reset all Margins to 0.25 inches (Fig.7) 

 Check the box next to Enable Shrink-to-Fit  (Fig.7) 

 Under Headers and Footers, change all fields to Empty (Fig.7) 

 Click on OK

*NOTE:  Some printing problems may be resolved by downloading

the latest Postscript (PS) printer driver from the printer’s company website and

reinstall the driver.

Adjust Screen Resolution    Change the appearance of  your display 

 On the desktop, right-click on an empty space

 Click on Screen Resolution

 Change Resolution  to the (recommended) setting depending on the monitor

 Click Apply, and then click OK

Clear Cookies and Temporary Internet Files   Clear copies of web pages visited  (Repeat as needed for maintenance.) 

 Open Internet Explorer  {Fig.8} 

 On the Tools menu, click Internet Options

 On the General tab under Browsing History, Click on the Delete button (Fig.8) 

 Select the check boxes next to:Temporary Internet files, Cookies & History (Fig.9) 

 Click the Delete button

at the bottom

 Click on OK

  {Fig.9} 

MAC 

Pop-up Blocker   Turn off the Pop-up blocker for the Welligent website 

 Top left of the screen, click on Safari  menu  {Fig.10} 

 Click on Preferences

 Click on the Security  icon found at the top of the row (Fig.10)

 Under Web content, uncheck Block Pop-up windows it should not have a

checkmark in front of the choice (Fig.10)

 Top left, click on the Red button to close window

Clear Cookies and Website Data Clear copies of web pages visited  (Repeat as needed for maintenance.) 

 Click on Safari menu, click on Preferences    {Fig.11} 

 Click on the Privacy  icon found at the top of the row (Fig.11)

 Click on Manage Website Data (Fig.11)

 Once Website Data loads, click on Remove All button

 Click on Remove now button

 Click on the Done button

 Top left, click on the Red button to close window

Welligent Technical Guide V8 
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Welligent Technical Requirements: PDF Forms

1 Welligent Technical Requirements: PDF Forms 
10/6/2017 

Opening a PDF form in Welligent 

When opening a PDF form, 
ensure the top section of the 
form displays a purple bar 
and states “Please fill out the 
following form……”. 

If the form displays a yellow 
bar at the top, click on 
Options and select “Add 
Host To Privileged 
Locations”.  This will change 
the yellow bar to purple and 
allow the student data to 
pre---populate. 

If PDF forms do not pre---populate with student information, follow the steps 
provided below to adjust your Adobe Reader settings. 

Install the latest version of Adobe Reader 

1. Open Internet Explorer
2. In the address bar type “www.adobe.com/downloads” and press enter.
3. At the bottom, under Downloads, Click Adobe Acrobat Reader DC
4. Uncheck any optional Offers and Click Install now
5. Click Run
6. Click Next
7. Once finished, click Finish

REF-6241.3
Office of the General Counsel; Date: 10/17/2017

Attachment A

http://www.adobe.com/downloads


Welligent Technical Requirements: PDF Forms

2 Welligent Technical Requirements: PDF Forms 
10/6/2017 

Adobe Reader Settings for Internet Explorer users 

“Add Host To Privileged Locations” can 
be verified in Adobe Reader. 

1. Open Adobe Reader
2. Click Edit
3. Click Preferences
4. Click Security (Enhanced)
5. Ensure welligent.lausd.net is

listed as one of the Trusted Sites.

Internet Explorer settings can be 
verified in Adobe Reader. 

1. Open Adobe Reader
2. Click Edit
3. Click Preferences
4. Click Internet
5. Ensure all three checkboxes

are checked.
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3 Welligent Technical Requirements: PDF Forms 
10/6/2017 

Enable Adobe PDF Plug---ins in Internet Explorer 

Enable Plugins 
1. Open Internet Explorer
2. Click Tools
3. Click Internet Options
4. Click Programs
5. Click Manage Add---Ons
6. Click Toolbars and Extensions and enable all Adobe application add---ons
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4 Welligent Technical Requirements: PDF Forms 
10/6/2017 

For Safari users (version 7 and below), Reset Safari Settings 

MAC: 
1. Open Safari
2. Click Safari
3. Click Reset Safari
4. Check all checkboxes then click Reset

Windows: 
1. Open Safari
2. Click Safari Settings
3. Click Reset Safari
4. Check all checkboxes then click Reset
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Welligent Technical Requirements: PDF Forms

For Safari users (version 8 and above), adjust Safari Settings 

MAC: 
1. Open Safari
2. Click Safari Settings
3. Click Preferences
4. Click Security
5. Check the box next to Allow Plug---Ins
6. Click Website Settings next to Allow Plug---Ins

7. Click Adobe Reader
8. Select Welligent url (welligent.lausd.net)
9. Select Allow Always

REF-6241.3
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Welligent Section 504 Program Module Quick Sheet 
   Attachment B 

1c. 

I. FREQUENTLY USED FEATURES 
 

1. LOCATING A STUDENT RECORD/STUDENT RECORD SEARCH  
 

a. Select the “Student Search” tab at the top of the Welligent screen 
 

 
 

b. Enter Student* ID # in the “Agency ID/Client ID” field 
• If Student ID is unknown, enter 

1. “Last  Name” 
2. “First Name” 

c. Click “Show All Fields” if you need to enter more information such as 
1. Date of Birth in the “DOB” field 
2. School of attendance in “Location” field 

 

 
 

d. Click the “Search” button at the top right hand side of the screen 

 
 
 
 

 

 

 

1a. 

1b. 
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 *Based on the student information entered, one of the two following screens should appear: 

 If Student ID number is entered, select “Program History”:                           

                                                            
 If the student’s name is entered, locate the student record below and select “Edit”:                                          

 

2. LOCATING THE SECTION 504 STUDENT RECORD 
a. Select “Program History” in the Record Navigator or the          icon  
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3. CREATING THE SECTION 504 STUDENT RECORD FOR THE FIRST TIME 

a. Click “New”  

 

b. Select “Enroll” 
c. Click “Save” 

 
 
4. EDITING THE SECTION 504 STUDENT RECORD 

a. Select “Edit” under  “Program History” 

 

3b. 

3c.
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5. UPDATING SECTION 504 DETAILS and CREATING FORMS 

a. Enter information in “Section 504 Details” or “Section 504 Exit Details” for each phase of the process as appropriate 
b. Click the “Save” button to save updated Section 504 Details and/or Section 504 Exit Details 
c. To create a new Section 504 form, click the green plus sign for Phase I, II, III, or IV as appropriate and the documents 

required for that phase                        

 
 
 
 
 
 
 
 
 
 
 
 
 
 

5a. 

5c.
 

5b.
 

5a.
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Welligent Section 504 Program Module Quick Sheet 
   Attachment B 

d. Upon opening the form, some student information should pre-populate into the fields; however; if student information 
does not pre-populate, it is a warning that the information you type will not save so your computer settings may need to 
be adjusted according to Welligent ITD Technical Support (Attachment A) 

e. Enter the information on the form as appropriate 
f. To save the document, select “Save Form.”   

 
 

g. Upon the data being saved, the following confirmation message will appear 

 
 

6. CREATING FORMS FOR A RE-EVALUATION 
a. Click the black plus sign to the left of the green plus sign for the relevant re-evaluation phase 

 

5f. 

5d. 

5e.
 

REF-6241.3  October 17, 2017 
Office of General Counsel 

Page 5 of 14 
 



Welligent Section 504 Program Module Quick Sheet 
   Attachment B 

b. Select “Add” to create a revised form for the re-evaluation 

 
 
c. Click “OK” when the following message appears 

 

d. Type the updated information on the form and click “Save Form” 
e. Click “OK” when the confirmation message appears 
f. Click “Close” 

 

g. The revised form for the re-evaluation will appear below the previous document 

 

6f. 

6d. 
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7. ATTACHING RELEVANT SECTION 504 DOCUMENTS TO THE STUDENT RECORD (Note that documents may not be deleted after 
they have been locked or uploaded) 

a. Click the drop down arrow next to “Paperwork/Forms” and  select “Attachments” 

 

b. Any previously attached documents will appear in the “Attachments” window 
c. Attach required documents by clicking the “New Attach” button 

 
 

d. When the Welligent Upload window appears, enter a brief description of document that will be uploaded, i.e. “504 Plan 
2/14/2014,” “Parent Input form 2/12/2014,” etc… 

e. Click “Browse” button to locate the file to be uploaded 

 
 
 
 
 
 
 
 
 
 
 
 

7d. 
7e. 

7b.
 

7c.
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f. Locate and select the file to be uploaded 
g. Click “Open” 

  
            

h. The file should appear in the “Upload File” field 
i. Click “Upload” 

 

j. Once the document is uploaded, a confirmation message should appear 
k. Click “Okay” to proceed 

 
 

 

 

7f. 

7g. 

7h. 

7i. 
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   Attachment B 

 

l. After clicking “Okay” if a confirmation window pops up, “select “Save” 

 

m. If a pop up window appears instead of the attached document, close it by clicking the “x” and then click “Save” 
n. Click “Close” to close the window 

 

o. If the attached document appears, close it by clicking the “x” otherwise go to the next screen below (7p.) 

 

p. Select “Close” to return to the Section 504 Details screen 
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   Attachment B 

 

q. Select “Refresh” and the attached document(s) will appear 

 

 

II. ADDITIONAL FEATURES 
 

8. RECEIVING SYSTEM ALERTS 
a. Upon the enrollment of a student with an “Eligible” or “Pending” Section 504 status, all users at the receiving school 

with “School-Administrator” roles will receive the automated message below: 

 
 
9. DELETING A SECTION 504 FORM (ONLY USE THIS FEATURE WHEN FORMS WERE MISTAKENLY CREATED)  

Forms may not be deleted after they have been locked or uploaded.  Instructions for locking a form can be found in Section 11. 
a. Click the black plus sign icon for either phase I, II, III, or IV, as appropriate, to locate the form to be deleted 
b. The number in parenthesis reflects the number of forms created in each phase 

 

 

 

10a. 

10b. 
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   Attachment B 

 

c. Upon locating the document/form to be deleted, click “Edit”  

 
 

d. Click “Delete”  
e. To delete the form click “OK”  

 

f. Upon deleting the form, a confirmation message should appear.  Click “OK” 

 

g. Upon returning to the Student Data window,  click the “Refresh” button 
h. The number in parenthesis should reflect the quantity of form versions 

 

 

10h. 

10g. 

10e. 

10d. 
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10. LOCKING a SECTION 504 FORM (This only applies to forms that were created in the Welligent Module.  This feature does not 
apply to forms that were uploaded/attached) 

a. Click “Edit” to open the form to be locked 

 
 

b. Upon opening the form to be locked, select “2-Review and Approval” from the menu 

 
 

c. Verify your user account and enter password below 

 
 

d. Click “Verify/Sign”                                                                                                                                                                                                                      
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e. When the confirmation message appears, click “OK.” 

 

11. GENERATING A SECTION 504 REPORT 
a. Click “Reports”    

 

b. Select “Section 504 Reports” from the drop down menu  

 

c. Select the desired Section 504 report by clicking the corresponding box 
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   Attachment B 

 

d. Select the school or District location as appropriate from the drop down menu by clicking the arrow.  You may customize 
the report by Section 504 status.  To generate a report of all students with 504 activity, leave the “Section 504 Status” 
field blank. 

e. After selecting the school or District location, click “Run”  
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